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RICK SAMMON
is a Canon Explorer of Light, has 17 classes on KelbyOne, is a popular 
instructor at Photoshop World, and is a longtime friend of this mag-
azine. He has also published 36 books, including HDR Photography 
Secrets, Exploring the Light, and Digital Photography Secrets.
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SEÁN DUGGAN
is the co-author of Photoshop Masking & Compositing,  
Real World Digital Photography, and The Creative Digital  
Darkroom. He leads workshops on digital photography,  
Photoshop, and Lightroom. Learn more at SeanDuggan.com.

MARTIN EVENING
is a photographer with a background in commercial studio  
photography. He’s also an experienced technical reviewer,  
who has over the last two decades authored 25 books on  
Photoshop and Lightroom.

SERGE RAMELLI
is a cityscape and landscape photographer who hosts a weekly 
show where he shares his best photography tricks and postprocess-
ing techniques. He specializes in HDR, black-and-white, and long-
exposure photography of some of the nicest cities in the world.

SEAN MCCORMACK
is the author of The Indispensable Guide to Lightroom CC. 
Based in Galway, Ireland, he shoots subjects from musicians,  
models, and actors to landscapes and architecture. Learn more 
at http://lightroom-blog.com.

ROB SYLVAN
is the Lightroom Help Desk Specialist for KelbyOne, on staff at the 
Digital Photo Workshops, and author of Taming Your Photo Library 
with Adobe Lightroom and Lightroom 5: Streamlining Your Digital 
Photography Process. Learn more at www.lightroomers.com.
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Cutting Through the  
CC Confusion

As you might imagine, there’s still a lot of confusion 

about Lightroom Classic and Lightroom CC, and with 

the mobile version also being called Lightroom CC, well, 

it’s challenging. 

If you were to visit Adobe’s Lightroom homepage 
right now, do you know what you won’t find? A single 

word about Lightroom Classic. The entire page is about 

Lightroom CC (the new cloud-storage-based version of 

Lightroom), so if you’re a new user and you go to that 

page, all you’re going to learn about is this new version, 

whether it’s right for you or not.

At the bottom of the page are the pricing plans, 

and that’s the first time you see that Lightroom  

“Classic” is included with two of the plans, but of 

course, there’s no description of what Classic even is, 

or why you might want to use it instead. If you click 

any of the “Learn More” links to dig a little deeper, 

it takes you to a page about how awesome the new 

Lightroom CC is, and at the bottom there’s finally a 

sentence with a link that reads, “The Creative Cloud 

Photography plan also includes Lightroom Classic CC 

for desktop-focused editing.”

So, it seems to me, based on how these pages are pre-

sented, Adobe is essentially driving everyone to the new 

cloud product. What does that mean for us Classic users?

In October, on Adobe’s official Lightroom blog 

called the Lightroom Journal, Tom Hogarty (Direc-

tor of Product Management at Adobe) posed and  

answered this question: 

Q. Is Lightroom Classic being phased out? How 
long will it be until Adobe kills Lightroom Classic?
TH: No, we’re not phasing out Lightroom Classic and 

remain committed to investing in Lightroom Classic in 

the future. We know that for many of you, Lightroom 

Classic is a tool you know and love and so it has an 

exciting roadmap of improvements well into the future.

 

I’ve known Tom for many years, and I believe him. 

Now, if we could just get Adobe’s marketing and Web 

folks to believe the same thing. 

I wish Adobe would explain the awesome new Light-

room CC the way I saw Lightroom author and expert 

Victoria Bampton did in Adobe’s Help Forums. In re-

sponse to a recent comment in those forums, she wrote: 

“The new Lightroom CC app is brand new, and 

is targeted at amateur photographers, at least at 

this stage. Their professional application is called  

Lightroom Classic.” 

That’s it—short and sweet (well said, Victoria). 

Lightroom Magazine

A Note from Scott  |  A FEW WORDS FROM THE EDITOR
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All my best, 

Scott Kelby

 KelbyOne President & CEO 

Editor & Publisher, Lightroom Magazine
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AND INSTRUCTORS GO TO HANG OUT
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We launched the KelbyOne Community last year, and 

it has grown way beyond our wildest expectations 

with more than 44,000 posts by 12,000+ members. 

This is the place where KelbyOne members go to make 

suggestions or ask questions on everything from 

Photoshop and Lightroom to photography and design 

to online classes and this very magazine. Our amazing 

(and we mean amazing!) moderators, instructors, and 

other members are in there every day ready to help. 

You’ll even see Scott Kelby zipping around from topic 

to topic helping out members.

To make it easy for you to ask questions about online 

courses, you’ll find a “Discuss this Course” button on 

every course page. Just click that button, and you’ll be 

taken to the topic that’s already been created for that 

course. And there’s a good chance that someone has 

already answered your question. So don’t be shy; click 

that button and start discussin’.

We did the same thing for Photoshop User and  

Lightroom Magazine, as well. See that little “Discuss this 

Issue” button down there on the lower left of this page? 

Just click it and you’ll be taken to the topic that’s already 

been created for this issue. Have a question about a  

tutorial in the following pages? Just click the big orange 

button at the end of the tutorial, and ask away. Either 

the author or managing editor (that’s me!) will give you 

a helping hand. Or if you just want to make a sugges-

tion for improving the magazines, we’re listening. n

Discuss this Issue

http://community.kelbyone.com/
http://community.kelbyone.com/t/lightroom-magazine-issue-37/
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Wed. May 30th  |  In-Depth Workshops (separate registration & fee required), Meet-Up,  
and First Time Attendees Orientation 

Thurs. May 31st  |  Keynote, Classes, Portfolio Reviews, Partner Pavilion, Get Ready to Go Pro, 
Dinner with a Stranger, and After-Hours Party

Fri. June 1st  |  Classes, Photo Shootout, Live Natural Light Shoots, Partner Pavilion,  
Midnight Madness, and An Evening with Jeremy Cowart

Sat. June 2nd  |  Classes, Guru Awards & Wrap-Up Ceremony

The Creative Conference for 
People Just Like You!

It’s where an exciting mix of Photoshop users, Lightroom fanatics, photographers of all types, graphic 

designers, and people from all over who use Adobe’s Creative Cloud apps come to leave the world behind 

to totally immerse themselves in three days of incredible in-depth training, creative inspiration, and fun. It’s 

about losing yourself in a flood of new ideas, new techniques, and new, faster, better ways to do things. 

Photoshop World is jam-packed with hands-on training, fun events, networking, and opportunities to interact and 

meet the best instructors in the photography and design community.  With six specialized tracks each day and 

over 100 classes and live shoots, we have the right training for you, regardless of your skill level. Photoshop 

World 2018 will be held in the Hyatt Regency Orlando, Convention Level from May 31—June 2. We  

guarantee this is the most fun you’ll have learning, but don’t take our word for it. Visit photoshopworld.com  

to see what our attendees have to say.

View all the Photoshop World 2018 highlights  
at photoshopworld.com/events

Three Days of Non-stop Photoshop,  
Lightroom and Photography Training

Adobe, the Adobe logo, Photoshop, LIghtroom, Creative Cloud are all registered trademarks of Adobe Systems, Incorporated. 

Photoshop World

http://photoshopworld.com
http://photoshopworld.com/events


View all the Photoshop World 2018 instructors  
at photoshopworld.com/instructors

Instructors, classes, and class materials may change without prior notice. Visit www.photoshopworld.com for the latest schedule and information

     Scott Kelby                     Joe McNally                  Peter Hurley                 Jeremy Cowart             Moose Peterson

Matt Kloskowski       Roberto Valenzuela              Glyn Dewis                     Dave Black                     Kalyee Greer 

     Tim Wallace                 Serge Ramelli                   Terry White                 Kristina Sherk                   Rob Sylvan

Instructors
Get Ready to Learn From the Best

We all know the difference a great teacher can make and that’s why only the world’s best instructors are invited  

to speak at Photoshop World. Our instructors take the stage to share the latest techniques, tips, and time saving 

tricks. Best of all, we’ve made sure to include time for you to interact with them after each class and at events. 

Don’t miss out on your chance to meet your favorite photography/Photoshop/Lightroom instructor.

http://photoshopworld.com/instructors
http://photoshopworld.com


After-Hours Party

Midnight Madness

In-Depth Workshops

Keynote Address

Live Natural Light ShootsGuru Awards



Customize Your Learning  Experience

View the entire Photoshop World 2018 workshops' schedule 
at photoshopworld.com/workshops

With six specialized tracks each day and over 100 classes and live shoots, we have the right training for you, regard-
less of your skill level. Create you own custom training experience by following one specific track each day or skipping 
between multiple tracks. We have color-coded each track for easy identification so that you can spend more time 
learning and less time roaming the halls. 

IN-DEPTH WORKSHOPS (05.30.18) SCHEDULE

Come the day before the conference kicks off for our optional in-depth pre-conference workshops. These intensive 
workshops provide a deep dive into the topics you want to learn most with small class sizes, live shoots, and hands-
on training. Separate registration & fee required. 

Characters on Location  | Joe McNally

Cityscape Retouching: A Live Shoot  |  Serge Ramelli 

Train your Eye to SEE and CREATE  
Better Poses  |  Lindsay Adler 

Lightpainting  |  Dave Black 

Overcoming The Challenges of Location Shoots  
Frank Doorhof 

Photo Safari  |  Moose Peterson

Photoshop Essentials for Beginners  |  Dave Cross

Photograph Like a Thief: From Concept to Print  
& Everything Between  |  Glyn Dewis

Building Your Portfolio  |  Stella Kramer

Pro Techniques for Lighting Automobiles!  
A Live Shoot  | Tim Wallace

http://photoshopworld.com/schedule


Moose  
Peterson

Rick  
Sammon

Dave  
Cross

Jesús 
Ramirez

Tim 
Wallace

Matt
Kloskowski

Modern Day Wildlife Photography  |  Photography

Adding Impact to In-Camera Images  |  Photoshop Effects

Selections & Masks Demystified  |  Photoshop Essentials 

Mastering Photoshop Blending Modes  |  Graphic Design

Stock Photography: How to Shoot It & Sell It  |  Business/Career

Luminosity Mask Basics in Lightroom & Photoshop  |  Lightroom

View the entire Photoshop World 2018 workshops' schedule 
at photoshopworld.com/workshops

Kim Griffen  |  PSW Guru Winner

DAY 1 (05.31.18) SCHEDULE

Lindsay  
Adler

Glyn  
Dewis

Bryan O’Neal  
Hughes

Dave  
Cross

Stella  
Kramer

Scott 
Kelby

High Impact Images: Create Photos that WOW  |  Photography 

Photoshop Lighting Effects for Photographers  |  Photoshop Effects

A Modern Photo Restoration  |  Photoshop Essentials

Intro to Illustrator  |  Graphic Design

50 Things You Need to Know to Succeed, Part 1  |  Business/Career 

Simplified Lightroom Image Management System  |  Lightroom
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Dave  
Clayton

Stella  
Kramer

Julieanne
Kost

The Art Behind the Headshot–Top 10 Tips  |  Photography

Photo Styling with Photoshop Color Lookup Tables  |  Photoshop Effects

Digital Darkroom Essentials: Landscape  |  Photoshop Essentials

Getting Started with InDesign  |  Graphic Design

50 Things You Need to Know to Succeed, Part 2  |  Business/Career

Using Lightroom with Photoshop: When & Why?  |  Lightroom
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View the entire Photoshop World 2018 schedule  
at photoshopworld.com/schedule

DAY 2 (06.1.18) SCHEDULE

Kaylee 
Greer

Dave 
Black

Mark 
Heaps

Dave 
Cross

Lindsay 
Adler

Matt 
Kloskowski

The Secrets to Creating the Best Dog Photos   |   Photography

SPORTS Action High Speed Sync FLASH   |   Lighting/Flash

Digital Color & Tone Fundamentals  |  Photoshop Advanced Techniques 

The Power of Using Photoshop, Illustrator & InDesign Together  |  Graphic Design

Plan, Shoot & Publish a Fashion Editorial  |  Motivation/Inspiration

Lightroom Mobile: Landscape & Travel Photographers  |   Lightroom

Peter
Hurley

Lindsay 
Adler

Julieanne 
Kost

Corey 
Barker

Kaylee
Greer

Serge 
Ramelli

Top 10 Headshot Blunders  |   Photography

 Portraiture as a Work of Art: A Live Shoot  |  Lighting/Flash

Advanced Photoshop Tips & Tricks  |  Photoshop Advanced Techniques

Improv Photoshop & Illustrator Hour  |  Graphic Design

Live Your Dream Career!   |   Motivation/Inspiration 

Cityscape Master Class   |  Lightroom

Tracy 
Sweeney

Frank 
Doorhof

Lindsay 
Adler

Dave 
Cross

Tim 
Wallace

Rob 
Sylvan

Creative Newborns: Posing, Styling & Workflow  |  Photography

Creating Magic with Less: A Live Shoot  |  Lighting/Flash

Color Grading: For Mood & Impact  |  Photoshop Advanced Techniques

The Power of Photoshop Presets  |  Graphic Design

‘Dude Nobody Sees My Work’  |   Motivation/Inspiration 

Lightroom Mobile: Creating Your Own Looks  |  Lightroom
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Sean Ferguson  |  PSW Guru Finalist
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Ramirez

Terry  
White

Joe  
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Kristina
Sherk

Landscape Photography: Beyond Sticks & Stumps  |  Photography

Lightpainting: Fun in the Dark  |  Lighting/Flash

Making Realistic Composites in Photoshop  |  Photoshop Advanced Techniques

Create & Update Your Portfolio with Adobe CC  |  Graphic Design

A Year in the Life of a Photographer  |  Motivation/Inspiration 

Everyday Portrait Retouching in Lightroom   |  Lightroom

Airshows: Get Beyond the Crowd Shot  |  Photography

TBA  |  Lighting/Flash

Retro Down & Dirty Tricks   |  Photoshop Advanced Techniques

Get Inspired by Graphic Design   |   Graphic Design

Creative Practice: The Tortoise & The Hare  |  Motivation/Inspiration 

Lightroom’s Client Proofing & Sharing Online   |  Lightroom

Attend conference sessions in any track and move between them as you like. Instructors, classes, and class materials may change without prior notice. 

Visit www.photoshopworld.com for the latest schedule and information.
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The Right Stuff: A Sports Shooters Guide  |  Photography

Portrait Lighting is Easy, Trust Me!   |   Lighting/Flash

The Art of Magazine—Quality Skin Retouching  |   Photoshop Advanced Techniques 

How to Design Really Effective Ads!   |  Graphic Design

The Joyful Photographer: Run a Successful Child Photography Business  |  Motivation/Inspiration

Black & White: Today & Yesterday  |   Lightroom
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DAY 3 (06.2.18) SCHEDULE

Glyn
Dewis

Corey 
Barker

Moose
Peterson

Dave 
Cross

Justin 
Wojtczak

Terry 
White

Photoshop Power Hour   |  Photoshop for Photographers

Creating 3D Composites in Photoshop    |  Photoshop Compositing

Luminar: Filling the Void of Nik   |  Software/Plug-ins 

Illustrator Tips & Tricks   |  Graphic Design

DSLR Video Basics   |  Video for Photographers

Lightroom: Beyond Image Management   |  Lightroom

Tricks & Fixes to Make Photoshop Fun    |  Photoshop for Photographers

Compositing: Don't Get Stuck, Get Creating!    |  Photoshop Compositing

How to Contribute to Adobe Stock & Make Money   |  Software/Plug-ins 

Ten Tips & Tricks for InDesign   |  Graphic Design

Increase Your Photography Sales with Video   |  Video for Photographers

Making Awesome Prints in Lightroom   |  Lightroom

A Complete Photographer's Guide to Photoshop   |  Photoshop for Photographers

Compositing Techniques   |   Photoshop Compositing

Start of Finish Workflow with On1 Photo Raw   |  Software/Plug-ins 

Intro to Adobe Muse CC   |  Graphic Design

DSLR Interviews: Creating an Impactful Story   |  Video for Photographers

TBA   |  Lightroom
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Images courtesy of Brad Moore, Rob Foldy, Nick Pedersen, Scott Kelby, Don Clark, Kevin Newsome, Kim Griifen and Scharad Lighbourne.

Don Clark  |  PSW Guru Winner

host hotel



To Register or Inquire About Discounts/Group Pricing 
Visit photoshopworld.com/pricing or Call 1.800.201.7323

Hyatt Regency Orlando  |  9801 International Drive, Orlando, FL 32819

Our home for Photoshop World is the beautiful Hyatt Regency Orlando Convention Center conveniently 

located on International Drive. Placed within walking distance to Pointe Orlando with dozens of beauti-

ful shops, exciting eateries, and nightclubs, it’s the ideal location for a conference. Best of all, The Hyatt 

Regency Orlando is our host hotel too!

Special Event Rate Per Night: $159 plus resort fee, current Orange County room tax of 13.5% (subject to change). 

To reserve your room visit photoshopworld.com/travel. Resort fee includes complimentary self-parking for two  

cars/per room, in-room Wi-Fi connection, fitness center access (fitness classes, pool activities, and bike rental),  

10% off spa treatments and merchandise, (2) I-Ride Trolley tickets, local and toll free (800) calls, free faxes, and  

(2) 16.9oz bottles of water per day.

Stay Where the Action Is!

host hotel

Make your Photoshop World experience EXTRA special with one of our fun events. Whether you enjoy learning  

or connecting with other artists we have the right option for you. Our Pre-Con Workshops provide you with hands-

on learning while the After Hours Party lets you cut loose with other creatives! Want the best of both worlds? Try 
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We tend not to get fairly mild winters where I live, so when 

the snow does settle, it gives me a good opportunity to take 

photographs like the one shown here. The most important 

photographic advice I can offer is to dress warm and keep 

dry. There’s nothing worse than feeling uncomfortable in bad 

weather, and therefore distracted from your photography. 

A WINTRY SCENE ON 
IVINGHOE COMMON

Developing the Shot | BY MARTIN EVENING



One of the purchases I made this year was a pair of Sensatec 

gloves made by Head. These keep your hands warm, but are 

supple enough to let you work the camera controls. Plus, the 

index finger pads allow you to swipe an electronic screen. 

My daughter has a pair that come in handy for catching 

Pokémon, of which, I’m assured, there are many to be found 

in these woods. [For more tips on shooting in cold weather, 

see “Photography Secrets” on page 46.—Ed.] 

When photographing a high-key subject such as a 

snowy scene, I generally aim to overexpose by two thirds 

of a stop (or more) beyond what the camera meter tells 

me. If you don’t compensate the exposure, your photos 

will all end up too dark and be in need of an Exposure 

boost. At the same time, you don’t want to overdo the 

exposure compensation either, because you may just end 

up with burnt-out highlights, especially if you have, say, 

backlit clouds in a scene. 

In this instance the two-thirds compensation wasn’t 

quite enough and I had to lighten more in Lightroom. The 

panoramic sequence of photos was captured at a low ISO 

speed with the camera mounted on a tripod using a 70mm 

lens. I was then able to use the Panorama Photo Merge 

feature in Lightroom to merge the RAW photos to create a 

single master DNG panorama image that was 65 megapixels 

in size. 

You’ll notice how in the final step below, I used the soft-

proofing feature in Lightroom to preview how the photo 

would appear when printed using a fine-art matte finish 

paper. The aim here is to first establish the desired Develop 

settings to get the photograph to look good onscreen. Hav-

ing done that, you can then create soft proof virtual copies 

and readjust the Develop settings (with the soft proofing 

enabled) to compare the proof version with the master and 

get the proof preview to match expectations. For example,  

I often find it necessary to add more Clarity when printing to 

a matte paper. For more detail about soft proofing, please 

refer to the “Developing the Shot” article I wrote for Issue 
28 of Lightroom Magazine.
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Step One: I shot a series of seven pho-

tographs to complete a panoramic 

sweep of the view captured here. To 

begin, I selected all the photographs 

in the Lightroom Library module and 

chose Photo>Photo Merge>Panorama 

(Control-M).

Step Two: This opened the Panorama 

Merge Preview dialog. Because I had 

shot a single row of photographs, this 

generated an elongated panorama, so 

the best projection method to select 

here was Cylindrical. This created a more 

or less distortion-free panorama; how-

ever, to extend the panoramic image 

area to the boundary edges, I dragged 

the Boundary Warp slider all the way to 

the right. 

Step Three: I clicked on the Merge 

button in the Panorama Merge Preview 

dialog to render the panorama as a DNG 

master image. Once the render process 

had finished, I selected the panorama 

image and went to the Develop module 

(D) where I selected the Crop Overlay 

tool (R) to crop the right-hand side of the 

photograph slightly. 

L
IG

H
T

R
O

O
M

 M
A

G
A

Z
IN

E
 ›

 I
S

S
U

E
 3

7

24

Lightroom Magazine



Step Five: The As Shot white 

balance setting did a good job 

of neutralizing the snow so that 

it appears pure white; however, 

I wanted the snow scene to take 

on a cooler appearance. To do 

this I simply dragged the Temp 

slider to the left to apply a cus-

tom white balance. 

Step Four: In the Basic panel, 

I applied the tone adjustments 

shown here to lighten the Expo-

sure, but at the same time pre-

serve all the highlight detail in the 

snow-covered scene. I also used 

a positive Shadows adjustment 

to bring out more detail in the 

tree trunks, and lastly, adjusted 

the Whites and Blacks sliders to 

optimize the tone contrast. 
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Step Seven: To make sure the 

photograph was nice and sharp, 

I went to the Detail panel and 

adjusted the Amount slider to 

add more intense sharpening.  

I combined this with a 0.9 Radius  

setting, which suited the fine 

edge detail in the photograph. 

Because I had shot the original 

photographs at a 100 ISO set-

ting, I was able to set the Detail 

slider to +100 to further accen-

tuate the edge detail. 

Step Six: Having used the prima-

ry Basic panel tone adjustments  

to compress the tones in the 

scene, I now wanted to add a 

kick to the shadow contrast. To 

do this, I went to the Tone Curve 

panel and lowered the Darks and 

Shadows sliders. If you don’t see 

the sliders, click on the little curve 

icon at the bottom right of the 

panel. I also dragged the shadow 

tone range slider (just below the 

graph) as far left as possible. 
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Step Eight: While I was pleased with the way the photograph looked at 

Step Seven, I also needed to consider how it would look when printed on a 

matte fine-art paper. I checked the Soft Proofing box in the Develop module 

Toolbar (T) below the image and selected a Before and After preview mode.  

I then adjusted the Develop settings to get the Proof Preview to match the 

Master settings. In this instance I added some Clarity and readjusted the 

Tone Curve panel sliders to achieve as close a match as possible

Capture sharpening 
All RAW photographs require some level of capture sharpening, which is 

why Lightroom, by default, always applies a 25 Amount sharpening setting 

to RAW photos. Now, it has to be said that the default sharpening settings 

are a tad on the conservative side, but you can adjust this and the other 

default sharpening settings by visiting the Detail panel. 

When deciding how to customize the sharpening, it’s best to start by 

analyzing the image. Are there lots of fine and narrow edges in the photo? 

If so, a low Radius setting between 0.7 and 0.9 will help emphasize these 

more. Conversely, if the subject has softer edges, such as a portrait, this will 

suit a wider Radius of between 1.1 and 1.3. 

The Detail slider is best described as a “high-frequency concentrator,” 

which means that, as you increase the Detail above 25, it biases the amount 

of sharpening, applying more to fine edge areas and less to the wider edge 

areas. Settings below 25 suppress the amount of contrast in the halos. A 

useful tip to bear in mind here is that when sharpening landscape subjects, 

such as this one, that were shot at a low ISO setting, you can safely apply a 

high Detail setting. 

The Masking slider can be used to protect areas of soft contrast and pre-

vent them from being sharpened. Lastly, the Amount slider is like a volume 

control, where increasing the Amount adds more sharpness. n ALL IMAGES BY MARTIN EVENING
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Lightroom Laboratory | BY SERGE RAMELLI

When I first heard about Lightroom, I was still using Photo-

shop and Bridge. I’d open a photo from Bridge into Camera 

Raw, retouch it, and then repeat for each and every photo. 

It took so much time! This is why I want to show you how 

Lightroom has made this process so much faster. 

ALL PHOTOGRAPHERS  
SHOULD BE USING  
LIGHTROOM
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Presets and the Graduated Filter 
Presets are one of my favorite Lightroom features; it saves so 

much time. You can use presets in Photoshop, but Photo

shop doesn’t have the Radial and the Graduated Filters, 

which are precious to photographers for retouching photos. 

For example, I started with this photo in Lightroom. 

Start by selecting the preset that works best for your 

image. On this one, I selected a preset that I call Golden 

Hour Linear. 

Using a preset as a starting point, you can quickly tweak 

the settings to tailormake the image the way you want. 

After applying a preset, I follow my usual workflow. Here, 

I set Blacks to –9, Whites to +57, and Highlights to 47.  

I added a Graduated Filter (M) over the sky, and lowered the 

Exposure to –0.95 and added some blue by dragging the 

Temp slider to –32. I also set the new Range Mask feature 

found in the local adjustment tools to Luminance and set the 

Range slider to 61/100 so the Graduated Filter doesn’t affect 

the mountains.

Lightroom Magazine
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Radial Filters 
On this photo, I thought it would be 

nice to use a Radial Filter (ShiftM) 

to guide the eyes of the viewer to 

the center of the photo. I clicked on 

Invert so any changes would take 

place inside the oval boundary, and 

then raised the Exposure and low

ered the Clarity to soften the clouds. 

We could even do some dodg

ing and burning with Radial Filters 

to make the photo more dynamic 

and interesting. Rightclick inside 

an existing Radial Filter, and select 

Duplicate to make a copy of the fil

ter. In this example, I duplicated the 

Radial Filter twice. I dragged the first 

duplicate into position and resized it 

using the control points, and then 

added some Exposure (0.42) and 

Clarity (56). For the second duplicate, 

I raised the Exposure to 0.13 and the 

Clarity to 50. 

Lightroom Magazine
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Synchronize Your Photos 
When you shoot in manual, you usually 

have the same aperture, shutter speed, and 

ISO for images from the same photo shoot, 

so you have the ability to retouch a single 

image from the shoot and synchronize its 

settings with all the other photos from that 

shoot. Just edit your first photo, select all 

the images you want to synchronize in the 

Filmstrip, and click the Sync button near 

the bottom right. In the Synchronize Set

tings dialog, click the Check All button, 

and click Synchronize. 

Survey Mode 
Once you’ve retouched all your photos, you 

can compare your images at the press of a 

key. Press N to enter Survey mode, which 

displays all of the selected photos in a way 

that makes it easy to see which photos are 

going to work. You can Commandclick 

(PC: Ctrlclick) any image in the Filmstrip 

to add it to the group of photos in Survey 

mode. Then just pick your favorite from 

the group. 

That’s the power of Lightroom; it’s so easy 

to use, making it a great timesaver. Plus, 

you can be as creative as you want—the 

sky’s the limit! 

I’m giving you some of my Lightroom 

presets so you can play around and see 

how cool presets can be! To import presets 

into Lightroom, go to the Develop module, 

Rightclick on the set of presets to which 

you want to import the downloaded pre

sets, select Import, navigate to the presets, 

and click Import. I hope that this helps you 

save some time when editing your own 

images Lightroom. 

[KelbyOne members may download 

Serge’s Lightroom presets at http://kel-
byone.com/magazine.] 

ALL PHOTOS BY SERGE RAMELLI
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A resolution worth keeping this year is to print more of your 

photos. I’m not talking only gallery exhibit worthy photos, 

but photos of all sizes, subjects, and yes, even quality. There’s 

something extra special these days about holding prints, fill-

ing albums, and shuffling through a stack of printed photos 

that can’t be matched by social media sharing.

PRINT MORE  
PHOTOS WITH  
LIGHTROOM CLASSIC

Under the Loupe | BY ROB SYLVAN
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Prior to the holidays, my wife and I went through hundreds 

of recent photos and created a big batch of 4x6 prints. We 

taped them on walls, updated the fridge, and put the rest in 

a basket left in a prominent place. When friends and family 

visited during the holidays, the photos were a huge hit, and 

a lot of time was spent passing them around the table, shar-

ing stories, and remembering good times. Passing around an 

iPad wouldn’t have had the same impact. For this article  

I want you to just grab a bunch of photos and print them—

you can thank me later. 

Before we dive in, it’s worth noting that the Print module 

is one area of Lightroom that has some differences based on 

operating system, so I’ll share screen captures for both Win-

dows and Mac when needed. That said, there are far more 

printers and printer drivers than I own and can share, so be 

sure to consult your printer’s manual if needed. 

Before You Print
One of the most important things to do before printing is to 

gather up all the photos you want to print: Lightroom’s col-

lections are perfect for this job. My favorite method is to 

leverage the Target collection functionality. Here’s how: 

Step One: In the Library panel, select the first photo for your 

collection, and go to Library>New Collection, or click the + 

icon on the Collections panel and choose Create Collection. 

Or even faster, press Command-N (PC: Ctrl-N). 

Step Two: In the Create Collection dialog, give it a mean-

ingful Name and check the Set as Target Collection box. 

Click the Create button. 

Step Three: Now you can go through folders and collec-

tions looking for photos to print, and when you find one, 

select it and press the B key to add it to that target collection. 

This makes the process go a lot faster. You can even load the 

Paint tool (located in the Toolbar when in Grid view of the 

Library) with Target Collection and go nuts. 

Once you’ve gathered up your batch of photos to be 

printed, you should consider the aspect ratio at which you 

want to print them, and crop as needed. There are two rea-

sons for cropping: One is to improve overall composition, 

and the other is to change the aspect ratio. Most of your 

photos will exit the camera with a 2x3 aspect ratio, which 

conveniently is the same as a 4x6 print. If you’re including 

photos taken with a smart phone or some other camera, 

however, you might encounter a different aspect ratio from 

the start (such as 3x4 or even 1x1). You may even have 

cropped some photos previously at other aspect ratios. 

Photos in Lightroom don’t have a print size yet, only some 

number of pixels high by some number of pixels wide. This 

Lightroom Magazine



L
IG

H
T

R
O

O
M

 M
A

G
A

Z
IN

E
 ›

 I
S

S
U

E
 3

7

34

relationship between the height and the width is what we 

mean by aspect ratio. Our most common print sizes (4x6, 

5x7, 8x10, etc.) may or may not match the native aspect 

ratio of your photo. The easiest way to see this in Lightroom 

is to select the first photo in your collection and press the R 

key to jump to the Crop Overlay tool. Once there, click the 

Aspect drop-down menu and choose one of the presets for 

common print sizes (we’ll choose 2x3 / 4x6). If the crop rect-

angle matches the existing edge of your photo, then your 

photo is that aspect ratio (such as starting with a common 

2x3 aspect ratio and choosing the 4x6 crop). 

If you notice that part of your photo is being cropped, 

then your photo’s native aspect ratio doesn’t match the 

aspect ratio of the size you chose, and some cropping 

is needed to print the photo at that size. My photo was 

taken with an iPhone, so it started with a 3x4 aspect ratio, 

and I needed to crop to match the 4x6 aspect ratio. 

Cropping isn’t bad or good; it’s just what’s needed if 

you want to print a photo edge-to-edge (or borderless) at 

a given size. Modern digital cameras (even smart phones) 

create images with large pixel dimensions, and can han-

dle a bit of cropping without losing quality (especially for 

8x10 prints or smaller). Sometimes a good crop can elimi-

nate distractions along the edge and make a much more 

impactful photo, so even if you’re sticking with print sizes 

that match your native aspect ratio, you might still consider 

if each photo could benefit from a little “nip and tuck.” 

Now that you’ve gathered your photos and cropped as 

needed, let’s look at how to get them printed through the 

Print module. 

Using the Print Module 
Lightroom’s Print module is built with a variety of different 

print jobs in mind. If you expand the Layout Style panel, you 

can see there are three different styles. Each style is intended 

for a different type of printing job. Single Image / Contact 

Sheet is great when printing a single photo at a specific size 

(or a batch of photos at that size), or for printing a variety 

of different photos all at the same size on a page (think  

of a grid of photo cells with the same dimensions, like a 

contact sheet). 

Picture Package is for printing the same photo at a variety 

of sizes (imagine a package of school photos containing a 

single pose at different sizes). Custom Package allows you 

to print any number of different photos at different sizes 

with a lot of customization in the layout (this can be useful 
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for maximizing the space on 

a single sheet of paper, or for 

creating a poster-like layout). 

When it comes to simply 

churning out the prints, my 

go-to style is Single Image 

/ Contact Sheet. This way 

I can configure the size of 

the paper I’m using, create a 

layout of one or more photo 

cells, and send it off to my 

locally connected printer. 

My best advice for printing 

large amounts of photos at 

the same size is to use pre-

cut paper at that size, so you 

don’t have to spend time cut-

ting them out. If you do need 

to cut your prints, investing in 

a rolling trimmer will give you precision results. I buy big 

packs of 4x6 paper to have on hand for these kinds of jobs. 

Lightroom comes preloaded with a variety of print tem-

plates in the Template Browser. These templates can contain 

settings for everything from layout style to printer profile, 

and creating custom templates can be real timesavers. We’ll 

skip the preloaded templates for now so you can see how 

easy it is to start from scratch (clicking some of the pre-

loaded templates will change your paper size, so be mindful 

of that). I also suggest expanding the Guides panel and check-

ing all of the boxes to enable all the visual indicators designed 

to help you with your layout. The Ruler is especially helpful to 

confirm that the paper size matches your intention. 

Note: There’s an option under the View menu to display 

an Info Overlay containing the paper size and printer, but 

this hasn’t worked on Mac for a couple of versions now, but 

it does work on Windows. 

Here’s how to print a batch of 4x6s (but the same steps 

would work for any print size):

Step One: Choose the Single Image / Contact Sheet lay-

out style. 

Step Two: Click the Page Setup button near the bottom left 

of the Lightroom interface to access the printer driver. In the 

Page Setup dialog (PC: Print Setup), choose your printer, the 

Paper Size, and the Orientation of your print. This is where 

we encounter some operating system differences. 

On Mac, choose a 4x6 paper size that includes a border-

less option. Click OK to return to Lightroom. 

On PC, first choose the 4x6 paper size, then click the Source 

drop-down menu and choose the Borderless option (you can 

also find a Borderless checkbox under Properties, which seems 

to do the same). Click OK to return to Lightroom. 
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If you don’t choose a borderless option, you won’t be 

able to zero out the margins back in Lightroom (we’ll do this 

in Step Four). Lightroom takes its instructions from the set-

tings you dial into the printer driver. 

Step Three: Expand the 

Image Settings panel and 

check the boxes for Zoom 

to Fill and Rotate to Fit. 

Even though we previ-

ously cropped, Zoom to Fill 

ensures that the photo fills 

the cell you create. Rotate 

to Fit allows you to include 

portrait- and landscape-

oriented photos in the 

same batch, and ensure 

they’re rotated to fit the 

cell correctly. 

Step Four: Expand the Layout panel, and zero out the Mar-

gins. Set the Rows and Columns to 1, and set the Cell Size 

Height to 6 in and the Width to 4 in. 

At this point, you should see the first photo in your col-

lection filling the page in the main area of the Print module. 

If you’re unable to zero out the margins, make sure you’ve 

selected the borderless option back in Step Two. 

Note: It’s worth setting the Use menu in the Toolbar to 

Selected Photos to ensure you only print the photos you 

manually select (as opposed to the entire Filmstrip). 

Step Five: Expand the Print Job panel, and set the Print Reso-

lution (it’s fine to leave it at the default, or enter a value of 

your choice). Make sure the Print To drop-down menu at the 

top of the panel is set to Printer and not JPEG File. Print Sharp-

ening is optional, but I default to Standard for most prints. 

Step Six: Choose your Color Management path. In a per-

fect world, choosing Managed by Printer or selecting a 

specific printer profile (to put Lightroom in charge of color 
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management) should produce equally good results, but your 

mileage may vary. My suggestion would be to give your 

printer a chance by leaving it set to Managed by Printer, and 

see how it does. If you like the result, then you’re good to go. 

If you choose Managed by Printer in Lightroom, then you 

have to ensure that color adjustment is on in the printer 

driver (you can do that by clicking the Printer button to open 

the Print dialog). On my Epson printer, when Managed by 

Printer is on, my Color setting in the Print Settings (PC: Prop-

erties) dialog is active. 

The alternative is to choose the specific profile for your 

printer/paper combo via the Profile drop-down menu in the 

Print Job panel in Lightroom. This puts Lightroom in charge 

of color management, and when this is the case, the color 

adjustment setting in the printer driver needs to be disabled 

or set to off. 

If you decide to choose a specific printer profile in Light-

room, you want to find the one that specifically matches the 

printer model and brand of paper you’re using. Most print-

ers will install profiles for that company’s popular papers 

when you install the printer driver, but you may need to visit 

the paper company’s website to download profiles for any 

papers not installed. This is especially true for third-party 

papers (most sites also include instructions for installing 

their profiles). 

Do a test run with each option. In each case, ensure that 

only the printer driver or only Lightroom is managing color 

(not both at the same time), and compare results. Choose 

the option that you like best for your future prints, and don’t 

look back. 

Step Seven: Click the Printer button to access the printer 

driver. On Mac, in the Print dialog, go to Print Settings and 

choose your Media Type (this is the type of paper you’re 

using). Confirm your color management setting is correct 

based on what you chose in Lightroom. 

On PC, in the Print dialog, click Properties, then choose 

your Media Type, and confirm your color management set-

ting is correct. 

If all looks good, load your paper in the printer and click 

Print (PC: OK). 

Note: If your prints come out darker than expected, check 

Print Adjustment at the bottom of the Print Job panel and 

do a test with increased Brightness amounts until you get 

a result to your liking. Leave that setting enabled for future 

prints. You won’t see a preview of those sliders in Light-

room. You only see the effect in the actual print. 

Printing with Lightroom can seem like a lot of work at first, 

but once you’ve had a successful print run, you can save 

your settings as a template to make it a snap in the future. 

Before leaving the Print module, with all your good set-

tings dialed in, click the + icon on the Template Browser, 

give your template a meaningful name (consider including 

paper size and media type), and click Create. The next 

time you want to print a batch of photos with those set-

tings, click on the template, select your photos, head right 

to the Printer button, confirm your settings, and click Print 

(PC: OK) to send them to the printer. Here’s to printing 

more in 2018! n
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Skylum (formerly Macphun) is really pushing hard. We’ve seen 

the company’s fantastic Aurora HDR plug-in already, but with 

Luminar, they’re really aiming to fill the gap for those looking 

to avoid subscription services. Luminar 2018 is especially well 

suited for beginners to intermediate photographers. Even  

in plug-in form, it’s quite an extensive application, so in this 

article you’ll get a general overview of it, as well as a walk-

through using just some of its features. 

LUMINAR 2018

Maximum Workf low  |  BY SEAN MCCORMACK

https://macphun.com/luminar


Installation and Setup 
As Luminar is cross platform, download the relevant installer 

and run it. You can install it on up to five devices per pur-

chase. Even if you’re using Lightroom as a plug-in host, 

you’ll need to run the standalone version first to create the 

plug-ins (the same applies for Photoshop). 

Once Luminar is open, go to the Luminar 2018 menu (PC: 

File menu), and choose Install Plugins. 

Choose the ones you want to install and click Done when 

finished. You’ll get a warning to restart the application. 

Close Luminar as well. 

Most plug-ins appear in the Photo>Edit in menu, but 

for Luminar, you also have the option of using File>Plug-

In Extras>Transfer to Luminar 2018. What’s the difference? 

Well, the Photo menu option creates a rendered file that’s 

then brought into Luminar, while the Plug-In Extras menu 

sends the RAW file to Luminar directly. The RAW file won’t 

have any settings applied, and allows you to use Luminar’s 

RAW Develop filter to process the RAW file. For this walk-

through, we’re going to process the RAW file in Luminar. 

You’ll be presented with a dialog (below) offering four 

potential applications for which to create plug-ins: Adobe 

Photoshop, Lightroom, and Elements, and Apple Aperture. 
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Layout 
Luminar’s basic layout belies the amount of power available 

in the app. Let’s take a look at it.

1. Toolbar:  The toolbar at the top hosts a range  

of options:

a.  The Zoom options let you zoom in and out. Click-

ing on the percentage gives a range of fixed zooms 

and a Fit to Screen option. 

b.  The Eye icon lets you see the Before view, while the 

Compare icon lets you view the Before and After 

together. You can drag the yellow line in the center 

over the image to let you compare your processing 

over the whole image. 

c.  Click the Undo icon to reverse 

the previous step. Use History 

to jump back further. 

d.  Tools opens up access to Crop, Free Transform, 

Clone & Stamp, and the Erase tool. 

e.  The next two icons toggle on 

or off the Presets panel at the 

bottom and the Side panel on 

the right.

f.  Cancel closes the image, and Apply saves the image 

back to Lightroom.

2.  The Main Preview: All your changes and before/after 

previews are visible here. You can change the back-

ground color by Right-clicking away from the image 

and selecting a color from the menu that appears. 

3.  Presets: Here you have the various sets available  

in Luminar.

a.  Click on Categories to access all the sets. 
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b.  Click on a thumbnail to apply 

a preset. You can also fade 

the preset using the slider, or 

add it to the Favorite category 

by clicking the star. 

4.  Histogram: At the top of the Side panel is the Histo-

gram. Above this are three icons: They toggle off and 

on the Histogram, the Layers stack, and the Info sec-

tion. Clicking on the Histogram will toggle between 

color, RGB, red, green, and blue views. Clicking on the 

triangles to either side will show shadow or highlight 

clipping, which are referred to as Cold Pixels or Hot 

Pixels, respectively, in the UI. 

5.  Layers: One of the beauties of Luminar is that all the 

available filters or combination of filters can be put on 

their own layer and masked off/faded for significantly 

more local control than offered by Lightroom. 

6.  Filters: These are like the panels in Lightroom’s Develop 

module, only you can have as few or as many as you 

need. Combined with layers, you have an extremely 

effective way of controlling the looks in your image. 

You can add filters individually, or make use of Work-

spaces, which contain a range of customized filters. 

Filters and Workspaces 
Luminar has an extensive range of filters, so many that an 

article of this size couldn’t hope to touch on all of them. 

Check out the range by clicking on Add Filters. This reveals 

the Filters Catalog with all the available filters. 

Hovering over the name of a filter reveals a panel with 

an example image of the effect and descriptive text. If you 

know the name of the filter or even the type of effect you 

want, type it into the Search bar. 

Workspaces load sets of predefined filters, often for specific 

workflows, for example, Professional, Landscape, or Portrait. 

Professional is a really comprehensive set as shown below 

in closed-down form. 

Any set of filters you make can be turned into a workspace 

for future use. The main difference between a workspace and 

a preset is that presets contain exact settings for a look, while 

a workspace would contain the filters used, in a zeroed state. 

Lightroom Magazine
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Walkthrough 
We can’t cover everything, but we’ll high-

light some of the newer features in this 

walkthrough. Select Clear Workspace in the 

Workspace menu to clear all the filters, and 

then use Add Filters each time you see a new 

filter mentioned below. 

Step One: Our first filter is Raw Develop to 

bring out the most in the photo (you’ll find 

this under the Essential set of filters). Typi-

cally you’d want to correct exposure and 

color cast issues at this point.

Step Two: To change the image color, LUTs 

(Look Up Tables) are great. Using the LUT 

Mapping filter (under the Professional set), 

choose Beijing in the drop-down menu at 

the top of the panel. Set Amount to 52 

and Contrast to –9. We’ll change Satura-

tion near the end of the process. Increase 

the Filters Amount to 100 at the bottom of 

the panel. 

Step Three: To add some interest on the 

left of the photo, we’ll add some Sunrays 

(under the Creative set). Here we’re mak-

ing them act more like streetlights in the late 

Beijing evening. We’ve used Place Sun Cen-

ter in the drop-down menu at the top and 

set the Y slider to place the source out of 

the photo. It’s a matter of experimenting to 

find what suits the photo. Critical here was 

5 for Number of rays with a Look of 51 and 

Length of 72. 
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Step Four: A texture would be really cool 

here. In older versions of Luminar, you’d 

have to use a separate image layer, but the 

new Texture Overlay filter (also under Cre-

ative) allows you to add a texture image to 

an existing layer. With a Texture Overlay fil-

ter active, use Load Texture to navigate to 

and place a texture image over the photo. 

Choose a blend mode that looks good. 

Hard Light looks great with this texture. I 

don’t mind that it lightens the image. We 

can always darken the image with Exposure 

from Raw Develop if needed.

Step Five: The texture on the subject isn’t 

great, though, so hover over the Texture 

Overlay panel to reveal the Brush icon. 

Click it and select Brush from the drop-

down options. The masking options now 

show above the image preview on the left. 

Click Erase and paint away the texture over 

the subject. Click the Eye icon to the right 

of Mask to see exactly where you’re paint-

ing. Click Done near the top right when 

you’re finished. 

Step Six: It’s time to do some retouching 

on the subject. From the Tools drop-down 

menu at the top, choose Clone & Stamp. 

This will render a new layer on which we 

can clone. Using the settings near the top 

left, make a soft brush with Opacity set rea-

sonably low: 20% is good for control, 50% 

is better for speed. Remove blemishes and 

click Done to render the layer. 
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Step Seven: From the Layers stack, click 

the + icon and choose Add New Adjustment 

Layer. We’ll add a few finishing touches to 

this layer. First up, create a Vignette (under 

Essential) and darken the edges of the 

photo. Click Place Center and then click 

on the subject so the vignette is centered 

on the subject. Turn the Amount down to 

darken the vignette. 

Step Eight: Using Structure (also under 

Essential), turn the Amount up to make the 

photo grittier. Click the Brush icon to access 

the masking tools, and erase the filter from 

the face and body. 

Step Nine: We’re almost finished with 

our look, but the skin needs to be desatu-

rated—it’s just too orange. The Saturation/

Vibrance filter (under Essential) is perfect 

for this. This time use the masking tools to 

apply it to just the face and hands. To do 

that, click on Mask near the top left and 

choose Invert from the drop-down menu, 

which will hide the entire effect on the 

image. Now click the Paint option (instead 

of Erase), and paint where you want to add 

the effect. Click Done when finished. 
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Step 10: We mentioned that the skin might 

be too bright, but let’s darken the whole 

photo. Because we rendered a layer for 

cloning, we need to add the Develop filter 

on this layer rather than adjusting the RAW 

Develop settings on the original bottom 

layer. You’ll find Develop under Essential. 

Pulling Exposure down about half a stop 

looks great. 

Step 11: For the final filter, a little Boost of 

the Accent-AI Filter (under Essential) looks 

good. This filter is often great to use at the 

start of processing, but we’re just using it 

literally as an accent here. 

Saving All the Stuff! 
While hitting Apply will save the file back to 

Lightroom, it’s not the only thing you can 

save. Presets is the most obvious. To save 

looks for reuse, click the Save Filters Preset 

button at the bottom right. Just name the 

Preset then click Create New Preset. 

You can also go to the File menu and 

choose Save. This saves a .lmnr file, which 

is a sidecar file that holds all the information 

about what you’ve done in Luminar. Now, 

you can edit the file again in Luminar, so 

everything isn’t fixed once you’ve finished 

your edit. 

You could always save out the filters 

you’ve used as a Workspace for reuse later 

via the Save as New Workspace in the Work-

spaces drop-down menu. 

Illuminated 
Hopefully, it’s obvious that Luminar 2018 

is a really versatile photo and RAW editor 

with a host of useful options. It’s also worth 

noting that it’s not just a Mac application; 

Macphun (soon to be called Skylum) has a 

Windows version as well. n

ALL IMAGES BY SEAN McCORMACK 
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After
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Oh, the weather outside is frightful—as I write this piece  

during a January winter near-whiteout in Croton-on-

Hudson, New York. It’s 10° F outside, about the same tem-

perature as it was when I took the above photograph of 

the Ice Hotel in Quebec, Canada.

PHOTOGRAPHING IN 
CHILLY CONDITIONS

Photography Secrets  |  BY RICK SAMMON
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Before we get going with the how-to info, here are two 

quick tips relating to that Ice Hotel photograph: (1) Only stay 

in the Ice Hotel if you want to freeze your butt off while 

sleeping on an ice bed, because blankets don’t help much; 

(2) Apply the photography, processing, accessory, and cloth-

ing tips below to get a good image in snowy and chilly con-

ditions, where exposures and photographing can be tricky. 

Okay, let’s go! 

Mood Matters Most 

Snowy and icy conditions can create a dramatic mood for 

making photographs, especially when the sky is overcast. The 

possibility of making a photograph with a mood or feeling—

the most important element in a photograph—is a motiva-

tional factor for bundling up and going out to shoot. Bring 

a thermos filled with coffee or hot chocolate and enjoy the 

challenge, which can result in a feeling of accomplishment. 

Try Black-and-White 

Speaking of creating a mood, 

snowy conditions with lots of 

highlights and shadows can 

be ideal for producing moody 

black-and-white images. If you 

set out to make a black-and-

white image, try to “see” the 

scene in black and white, and 

you’ll begin to see values (the 

range of tones from dark to 

light) rather than seeing and 

being enamored by colors. 

This method of “seeing” can 

help you produce the best in-

camera image. That can be 

accomplished by setting the 

exposure for the highlights—

the brightest part of the 

scene—which is made pos-

sible by using your camera’s 

highlight alert and histogram. 

When producing a black-

and-white image, keep in mind 

that “contrast is king,” mean-

ing that contrast rules. My 

suggestion: If you boost the 

contrast a little, you’ll like the 

picture lots better. Also, select 

a red filter when processing 

your picture to make a blue 

sky more dramatic (darker). 

Mood Matters Most: Glacier Lagoon, Iceland 

Try Black-and-White: Antarctica
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Changing Lenses 

I try not to change lenses in chilly conditions, especially 

when it’s snowing, because snowflakes can land on a cam-

era’s mirror/sensor. If I need to change lenses outdoors, I do 

so under a waterproof camera bag cover. 

There’s also a reason not to change lenses inside right 

after you’ve been outside in the cold. If it’s cold outdoors 

and your lens and camera are cold, when you go inside and 

remove your lens, condensation can fog your camera’s mir-

ror/sensor, sometimes for a long time. Therefore, when you 

go inside to warm up, give your camera time to warm up 

too before you change lenses. 

Exposure Compensation 

Lots of white areas in a scene can fool a camera’s meter into 

thinking that the scene is brighter than in reality. The result is 

an underexposed image. The basic remedy for this situation 

is to add EV +1 to your exposure. Also check your histogram. 

Move the histogram to the right, by increasing the exposure 

in small increments, until your highlight alert is blinking, and 

then reduce the exposure until you have no “blinkies.”

Dealing with Contrast 

One of the main challenges of snow shooting is dealing 

with contrast—lots of darks and lights in a scene. Your 

goal should be to capture as much detail as possible in 

the shadow and highlight areas of the frame. Here, too, 

your highlight alert and histogram can help you get a 

good exposure. 

Antarctica

Antarctica

Antarctica



K
E

L
B

Y
O

N
E

.C
O

M

49

Lightroom Magazine

Reflections 

Harsh reflections on snow and 

ice can ruin a photograph. You 

may be able to avoid, or at last 

reduce, reflections by changing  

your shooting position and by 

waiting for the sun to move. 

You can also reduce reflections 

with a polarizing filter. More on 

the benefits of using a polariz-

ing filter in a bit. 

Snow Eyes

Take a look at the image on the right of the two photos above. Can you spot the Arctic 

hare? Hint: Look for the black eye. It’s the same animal pictured on the left. I took the 

close-up after the animal moved position. 

I share these photographs with you to illustrate the point that we sometimes need 

to use our “snow eyes” to spot a subject. Knowing what to look for helps us find sub-

jects. Scanning a scene from right to left, the opposite way we read (left to right) here 

in the U.S., slows down our eyes when we scan a scene, giving us a better chance of 

spotting a subject. 

Alaska

Churchill, Canada
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PROCESSING SUGGESTIONS 

Shadows and Highlights 

When you think about it, every photograph 

you’ve ever taken has one main element: 

light. Break that down and you have two 

sub-elements: highlights and shadows. 

When working in Photoshop or Light-

room, controlling those highlights and 

shadows is paramount, and relatively easy. 

Use those sliders to fine-tune those sub-

elements and to create dramatic images. 

HDR 

HDR (high-dynamic range) imaging is 

another way to control contrast and to get ice and snow 

images with impact. The higher the contrast range, the 

greater number of images you need. This HDR image was 

Shadows and Highlights: Glacier Lagoon, Iceland 

created from seven bracketed exposures. That high number 

of exposures was needed because I was shooting into the 

sun—a very high contrast situation. 

HDR: Alaska
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PHOTO ACCESSORIES 

Polarizing Filter

By reducing glare on water, a polarizing filter lets us, and 

our cameras, see through water. This is a nice benefit when 

photographing icebergs, which are actually larger in mass 

under water. 

One problem with using a polarizing filter is that you 

can over-polarize a scene, which results in a dark area in 

the center of the frame or dark 

bands in an image. For best 

results when using a polarizing 

filter, dial in the desired effect 

and then check your image on 

your camera’s LCD monitor. If 

you see dark spots/bands, dial 

back the effect. 

ND Filters 

Neutral density (ND) filters reduce 

the amount of light entering 

your lens, which lets you shoot  

at slower shutter speeds to create 

a silky-water effect. If you plan to 

photograph along the shore in chilly conditions, an ND filter 

is a valuable and creative accessory. 

When using an ND filter, experiment with slow shutter 

speeds. This Iceland picture (bottom) was taken at 1/5 of a 

second, but I have other ND filter photos that were taken 

with shutters speeds longer than 10 seconds. 

Lightroom Magazine

ND Filters: Iceland

Polarizing Filter: Antarctica
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Out of sight and inside my toasty jacket are two extra 

camera batteries. Like car batteries, camera batteries don’t 

like to be cold. The colder it is, the faster they drain. So 

always keep extra batteries warm inside your jacket.

My camera is protected with an Op/Tech rain/snow 
cover and I have AquaTech pads on two of my tripod legs, 

which, if you’re not wearing gloves, keep your hands from 

getting cold when carrying a cold tripod. 

My Think Tank backpack is protected from moisture 

because it’s covered with the waterproof cover that comes 

with it. 

Outdoorphotogear.com carries a wide selection of 

gloves, camera bags, rain covers, and tripod pads to keep 

your gear happy. 

CLOSING THOUGHTS

Be Prepared 

This is a shot (below left) of the Tundra Buggy we used for my 

Churchill photo shoot. It was taken on day three of a three-

day whiteout. For three days we couldn’t shoot because the 

weather conditions reduced visibility to the point where we 

couldn’t see very far from the vehicle. Fortunately, condi-

tions improved for the last two days of the trip. 

When you’re planning to shoot in snowy conditions, plan 

on spending more days than you think you need. You never 

know when a whiteout or near-whiteout can cause a photo 

blow out. 

Have Fun—But Be Safe! 

Here’s another important tip: Have fun but be safe.

If you’re dressed for success and have the photo know-

how, you can make some creative and fun photographs. 

But please keep in mind that chilly conditions can be chal-

lenging and even dangerous. You don’t want to slip on 

the ice and fall on the ground or into the water. Always 

keep safety in mind. 

So when you take a look at the picture at the top of the 

next page, you may think: Rick isn’t practicing what he’s 

preaching! He and his wife Susan are balanced on a piece of 

ice and can fall into the freezing water! Well, my friends, this 

picture was taken three feet from shore on the Hudson River 

in Croton-on-Hudson, New York. The water is only two 

inches deep, and the piece of ice on which we’re perched is 

stuck in the frozen mud of the riverbed. 

Lightroom Magazine

CAMERA CARE AND HANDLING 

Protecting Yourself and Your Camera 

A comfortable photographer is a happy photographer. 

Protected gear is happy gear. 

That’s me in my backyard, photographed on the day after 

I wrote this article. I’m wearing warm gloves, rain pants, a 

warm jacket, wool cap, snow boots, and sunglasses. Before 

I went out, I put on sunscreen, which also helps to protect 

your skin against wind. Had it been colder, I’d also have had 

hand warmers in my gloves and toe warmers in my shoes. 

Protecting Yourself and Your Camera: Croton-on-Hudson, New York 

Be Prepared: Churchill, Canada

https://optechusa.com/rainsleeve.html
https://optechusa.com/rainsleeve.html
https://aquatech.net/products/tripod-soft-wrap
https://www.thinktankphoto.com/?rfsn=166001.2bc98
https://www.outdoorphotogear.com/
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P.S. I’m adding a postscript and 

photo to this article because  

I wanted to back up my state-

ment about sleeping in the Ice 

Hotel. As you can see, the beds 

are carved out of ice. So even 

when you’re under the covers, 

it’s chilly. That said, the experi-

ence is very cool. n

Lightroom Magazine

Have Fun—But Be Safe! Croton-on-Hudson, New York 

ALL IMAGES BY RICK SAMMON
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Questions & Answers
Q.   I notice that sometimes when I use the Dehaze 

slider, especially if I apply a lot of Dehaze, I start 

getting some large color casts in parts of the image. 

Or, if I can see the sky in my image, the corners of 

my image turn dark blue (and sometimes the entire 

image starts to turn bluish). Is this normal? 

A.  It is—particularly because Dehaze is just another form 

of contrast (an extreme form of contrast, you might 

say), and that definitely can affect the overall color 

(just like adding regular Contrast makes all your col-

ors more vibrant). The trick that I use to get around 

these color shifts is once I apply a lot of Dehaze in the 

Effects panel, I go and lower the Vibrance amount in 

the Basic panel until it looks right again. That actually 

works amazingly well. 

   As for the bluish problem in the corners of sky 

images—the “bluing” part is that same contrast issue, 

but what you’re seeing in the corners is this extra con-

trast accentuating any lens vignetting already in your 

image. You might not notice the vignetting at first, but 

once you add a lot of Dehaze, any minor vignetting 

can suddenly become major vignetting. So, it might 

take going to the Lens Corrections panel to get rid of 

the vignetting, along with backing off the color using 

the Vibrance slider. 

Q.  I always make smart previews for the images I im-

port into Lightroom, but I’m not sure how they’re 

helping me. Is this worth doing or am I just wast-

ing time/space? 

A.  If you’re not editing photos on a laptop, and you have 

your originals connected to your computer, making 

smart previews won’t be a big help to you, because 

your originals are always available. The advantage of 

making smart previews is that you don’t need to have 

the original images with you to edit them in Lightroom, 

which is mostly helpful for folks who edit on a lap-

top and don’t want to haul a hard drive around with 

all their images. The smart preview allows them to 

work on a vastly smaller file-sized image that has the 

same properties as the original. Edits you make to the 

smart preview versions are automatically updated to 

the original high-res versions when you reconnect the 

hard drive where the originals live, so this is a big help 

for people who edit on the road. 

Q.  I don’t take that many images each year, so I’m 

considering switching to Lightroom CC [cloud-

based storage]. If I do store all my images in 

Adobe’s Cloud, and then I decide it’s not for me, 

how do I get my images back? 

A.  Adobe makes a free Adobe Lightroom Downloader 

app that will let you download all the images you 

stored in the cloud directly to your desktop computer. 

You can find the free downloader here. Once you’ve 

downloaded and installed it, launch the app, then click 

the Begin button. In a moment it will ask you to log in 

with your Adobe ID, then it analyzes your cloud-based 

image library and lets you know how many photos 

you have, and how much free disk space you’ll need 

to store them on your computer. Choose the folder 

into which you want them downloaded, and it starts 

the process of bringing them down (it automatically 

sorts them into folders by date). That’s all there is to it. 

Lightroom Magazine

SCOTT KELBY

https://lightroom.adobe.com/lightroom-downloader
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Q.  I’m using Lightroom Classic, and I want to move 

my photos from my current external hard drive  

to a larger external hard drive. How can I do that  

without Lightroom losing track of all my images? 

A.  Probably the best way is to first connect the larger hard 

drive to your computer. At this point, Lightroom can’t 

“see” this new drive, so to make it recognize this drive, 

go to Lightroom’s Folders panel, click the + button, and 

choose New Folder from the menu that appears. This 

brings up your standard operating system’s Open/Save 

dialog, so now you can search through your OS and 

locate that new connected drive. Once you’ve done that, 

click the New Folder button in the Open/Save dialog, cre-

ate a folder for your images on this newly attached hard 

drive, and click Choose. Because you did this through 

Lightroom, Lightroom will now see this new drive and 

folder in your Folders panel, and now you can drag your 

folders from your old connected external drive in the 

Folders panel to your new one. And since you’re mov-

ing them within Lightroom, Lightroom will know exactly 

where they are. 

Q.  If I want to try Lightroom CC [the cloud storage 

version of Lightroom], is there a way to get the 

Develop module presets I created in Classic over 

to Lightroom CC? 

A.  There is. It’s not the most elegant way, but it works. 

Start in Lightroom Classic by going to Lightroom (PC: 

Edit)>Preferences and clicking on the Presets Tab. 

Then click the Show Lightroom Presets Folder button. 

This will take you to the main presets folder where all 

your different types of presets are stored. Look inside 

this folder for the Develop Presets folder. Now you’re 

going to copy those over into the Develop Presets 

folder in Lightroom CC. To get to that folder, launch 

Lightroom CC, go to the Presets panel, click on the 

three little dots at the top right, and from the menu 

that appears, choose Open Presets Folder. Now just 

hold the Option (PC: Alt) key and drag the presets 

from your Classic Develop Presets folder (which should 

already be open) over to the now open CC Develop 

Presets folder to copy them. Restart Lightroom CC, 

and now they’ll appear in the Presets panel. I told you 

it wasn’t elegant. 

Q.  What’s the best way to apply a Develop preset to 

multiple images if they aren’t together (so, I want 

to apply it to certain individual images in a folder  

or collection, but not others)? 

A.  Well, there are a number of ways to do this—you could 

just hold the Command (PC: Ctrl) key, click on each 

image to which you want to apply the preset, and then 

once they’re all selected, you can simply go to the Pre-

sets panel and click on the preset. That would work, but 

here’s something that may be quicker, and it’s certainly 

way more fun. In the toolbar along the bottom of Grid 

view (G) in the Library module, click on the Painter icon 

(spray can). Click to the right of the word “Paint,” and 

from the pop-up menu that appears, choose Settings. 

Now click to the immediate right of that, and a pop-up 

menu appears with a list of your Develop module pre-

sets. Choose the preset you want to use, click on any 

thumbnail, and it applies that preset in one click. Give 

it a try—it’s more fun, and faster, than it sounds. 

Lightroom Magazine
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the different cell views in Grid View: one view has the 

numbers, the next view (which would appear if you 

pressed the letter J) would be the Expanded Cell view, 

and then finally the compact view but without the 

numbers. So, press the letter J once or twice to get 

back to the view with the large gray numbers. n

Q.  In the Library module, I used to see large light-gray 

numbers behind my thumbnails, but one day they 

just went away and I have no idea how to bring 

them back. What happened to them? 

A.  My guess would be that, at some point, you hit the 

letter J on your keyboard. That toggles you through 
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HANDS UP IF YOU WANT TO LOVE YOUR FLASH

HANDS DOWN,  
THIS IS THE BOOK 

THAT WILL  
GET YOU THERE

Standing in front of a room packed with 360 photographers at his seminar, Scott asked for a show of hands:  
“How many of you own some kind of an off-camera flash? A Nikon, Canon, Yongnuo, etc.?” About 340 hands went up.  
“Okay, I have one more question, but before you raise your hand, I want you to really think about your answer.  

Let’s see a show of hands—how many of you love using your off-camera flash?” Out of those 360 people, just four  
people raised their hands. He was stunned. That’s why this book was created—to help you finally fall in love with  
your flash—and the best news is, it’s way easier than you’d think. It’s time to fall truly head-over-heels in love with  

your flash, so you can start creating the type of images with your flash that you’ve always dreamed of.

http://rockynook.com/shop/photography/the-flash-book/
https://www.amazon.com/Flash-Book-hopelessly-finally-taking/dp/1681982749/ref=sr_1_25?s=books&ie=UTF8&qid=1509463304&sr=1-25&refinements=p_27%3AScott+Kelby
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Tips & Tricks
Since we’re starting off a new year, for this issue we’ll take 

a look at some essential January housekeeping tasks for 

Lightroom Classic CC, as well as explore some useful ways 

to take advantage of smart collections in your workflow. 

A New Copyright Preset for 2018 
If you’ve not already done so, now is a good time to make 

a new metadata preset for your copyright and contact 

info. If you already have a preset for this, just make a quick 

edit to the copyright preset for 2017 and then save it as 

a new preset for 2018. To do this, go to Metadata>Edit 

Metadata Presets. Open the Preset drop-down menu at 

the top of the dialog, choose your 2017 preset, and in 

the IPTC Copyright section, change the year to 2018. 

Then open the Preset drop-down menu again, choose 

Save Current Settings as New Preset, name your new 

preset, and click Create. 

If you’ve never made a copyright preset before, just 

open this dialog, enter your information, then save it as 

a new preset. You don’t need to fill out all of the info 

in the many fields that are available here; only use what 

you need. One final point of clarification: This is just a 

copyright notice and contact info that you add to the 

metadata in your files; it’s not the same as formally reg-

istering images with the U.S. Copyright Office. 

Applying Copyright Presets 
The best time to apply copyright presets is when you 

import photos into your Lightroom catalog. There’s an 

option for this in the Apply During Import section on 

the right side of the Import dialog. For images that are 

already in the catalog, use the Preset drop-down menu in 

the Metadata panel to apply a saved metadata preset to 

either a single image or a group of selected photos. 

Removing Old Catalog Backups 
While we’re considering New Year’s catalog housekeep-

ing, it’s also a good time to make sure that you don’t have 

too many old catalog backups cluttering up your hard 

drive. Whenever Lightroom makes a backup of the cata-

log (note that this is just the catalog and not the actual 

image files), it creates a Zip file and places this in your des-

ignated backup folder. If this folder isn’t cleaned out every 

once in a while, you could end up with a lot of backup 

files that take up a significant amount of hard drive space. 

If you’re not sure where your catalog backups are 

stored, go to the Lightroom (PC: Edit)>Catalog Set-

tings, and in the General tab, make sure that the Backup 

SEÁN DUGGAN
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Catalog drop-down menu is set to Every Time Lightroom 

Exits, and then quit the program. In the backup dialog 

that appears, you can see the location of your backup 

folder. If it’s been a while since you’ve backed up the 

catalog, go ahead and click Back Up. If you just want to 

clean up the Backups folder, click Skip this Time. 

Navigate to the Backups folder and see how many old 

backup folders are there. I usually only keep the most re-

cent three or four folders. Anything older than that is just 

not relevant anymore. I’ve run into cases working with 

clients where I’ve discovered literally hundreds of old back-

up folders, sometimes going back to previous versions of 

Lightroom. Depending on the size of your catalog, that can 

add up to a lot of storage space on your hard drive. Do 

yourself a New Year’s favor and free up some disk space! 

Taking Advantage of the  
Recently Modified Smart Collection 
Not long ago, one of my regular consulting clients asked 

me if there was a way to find a file in Lightroom that 

she had recently printed. While there’s no searchable 

metadata for a file that was recently printed, there 

is a default smart collection that will gather together 

Recently Modified files, and for my client, this did the 

trick in helping her locate the file. 

In the Collections list, look for the collection set labeled  

Smart Collections and you’ll find it there. Double-click  

on the name of any smart collection and you can edit 

the rules it uses to populate the collection. For the 

Recently Modified collection, the default is two days, 

but this can easily be changed to whatever you want. 

Recent imports, files with recently modified meta-

data (keywords, star ratings, copyright notices, color 

labels, etc.), or recently modified Develop settings will 

show up here, as will files that have been recently edit-

ed in Photoshop (assuming the journey into Photoshop 

began in Lightroom and the resulting saved file is part 

of the catalog). If a lot of files show up here (due to 

a recent import, for instance), remember that they’re 

governed by the Sort criteria, so an older image may be 

toward the top of the thumbnails in the smart collec-

tion if the Sort menu is set to Capture Date. To find the 

most recently edited shots near the bottom, set the Sort 

menu to Edit Time. 

Lightroom Magazine
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Smart Collections for  
Workflow Tasks: Keywords 
While we’re looking at the Smart Collections set, let’s 

consider some of the other ways that you can put this 

feature in Lightroom to work for you. Some of the 

starter smart collections that come with Lightroom may 

give you some ideas as to how you might use them, 

and a few are quite useful without any modifications. 

One of these is the one that gathers images Without 

Keywords. You can use this smart collection as a work-

flow tool to help you add keywords to images that  

currently don’t have them. Whenever you have some 

extra time, even only 5 or 10 minutes, you can open 

this collection and add a few vital keywords to many 

images, thus removing them from the Without Key-

words smart collection, and ensuring they’re much 

easier to find in the future. 

Smart Collections for Workflow Tasks: 
Copyright Notice 
As mentioned earlier, I typically add my copyright notice 

and contact information to files when they’re imported, 

but over the years of using Lightroom, there have been 

many times when I’ve forgotten this step. Smart collec-

tions to the rescue! 

Make a new smart collection by Right-clicking on 

the name of the Smart Collections set, and choose Cre-

ate Smart Collection. Using this method to make the 

new smart collection will automatically place it inside 

the collection set on which you right-clicked. Give the 

smart collection a name that makes sense (for mine,  

I named it “Needs Copyright Info”), then open the 

rule drop-down menu on the far left and choose Other 

Metadata>Copyright Status. Set the other menus so 

that files that aren’t copyrighted will be added to the 

collection, and then click Create. Then use the Presets 

drop-down menu in the Metadata panel to add the cor-

rect year’s copyright notice to the photos. 
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Smart Collections for Workflow Tasks: 
Remove Chromatic Aberration 
Another way that I use smart collections 

is to remind me of files in which I may 

have forgotten to remove chromatic 

aberration in the Develop module. Chro-

matic aberration is caused by lenses that 

don’t resolve the different colored wave-

lengths of light equally across the entire 

image. If present, it typically shows up as 

red/cyan (see image above), and some-

times purple/green, fringing along high-

contrast edges toward the outer part of 

the image (you need to zoom in to 1:1, 

and sometimes higher, to really see it). It 

tends to be more common with wide-

angle lenses, but can also show up in 

other lenses as well. 

To address this, I’ve created a smart 

collection that gathers any image with 

three or more stars that doesn’t have Remove Chro-

matic Aberration applied. I chose to limit it to higher-rated  

images simply because I don’t need to worry about it if an 

image isn’t being printed, and I generally only print images  

with three or more stars. While I’m removing chromatic 

aberration, I’ll also double-check to see if a lens profile is 

available for a shot and will apply that as well. n ALL IMAGES BY SEÁN DUGGAN
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